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Experiment HN-3: Human Nerve Conduction

Background

Each nerve fiber in a nerve is capable of generating an action potential which can be propagated along 

its length without any loss of amplitude or velocity. Nerve fibers that have large diameters, and are 

covered with the insulation of a myelin sheath, conduct impulses down their length with the highest 

velocities. The motorneurons that supply skeletal muscles are included in this category. Small 

unmyelinated nerve fibers, like the sensory fibers originating in digestive organs, are the slowest 

neurons in the body. 

When the motor and sensory neurons that are bundled together to create nerves are stimulated, the 

nerve produces a compound action potential (CAP), which is the summation of the action potentials 

from nerve fibers that are activated by the stimulus. As the strength of the stimulus is increased, more 

fibers in the nerve are recruited and the amplitude of the compound action potential is greater. The 

conduction velocity of the compound action potential is also related to the composition of the nerve; 

nerves with a greater number of large myelinated neurons have higher relative conduction velocities. 

Conduction velocities are often used to measure the relative health of the nervous system. A disease 

that affects the nervous system by damaging myelin sheaths, or destroying membranes and membrane 

transport, or constricting nerves can be indicated by changes in nerve conduction velocity (NCV) of the 

patient. NCV tests are performed when the following diseases or conditions are suspected: carpal 

tunnel syndrome, traumatic damage, poliomyelitis, diabetic neuropathy, chronic inflammatory 

polyneuropathy, and Guillain-Barre syndrome.

In this experiment, the ulnar nerve of a subject will be stimulated and the response of a muscle 

innervated by the nerve will be recorded as an indicator of nerve activity. Three aspects of nerve 

activity will be studied in this experiment: the relationship between stimulus strength and the amplitude 

of the nerve/muscle response; the latency of the nerve as a function of the polarity of the stimulus 

pulse; and the nerve conduction velocity. To measure nerve conduction velocity, the nerve will be 

stimulated at two different points along its length. Because the distance between the two stimulation 

points and time difference between muscle responses from those two positions can be measured, the 

nerve conduction velocity can be calculated.

The stimuli that stimulate the nerve and evoke the response recorded from the muscle will be generated 

by the iWorx SI-200 stimulus isolation unit or the built-in stimulator of the IXTA. These units will be 

programmed to provide mild electrical shocks to the nerve through the skin. The electrical stimulation 

of the nerves in the forearm is safe; but, standard safety precautions need to be observed. People with 

poor cardiac function, pacemakers, or any other condition that can be aggravated by electrical 

stimulation should not volunteer for this experiment. 
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Experiment HN-3: Human Nerve Conduction

Equipment Required

PC or Mac Computer

IXTA data acquisition unit

USB cable

Power supply for IXTA

C-ISO-B3G cable and three EMG lead wires

Disposable snap electrodes

HV stimulator lead wires 

IXTA Setup

1. Place the IXTA on the bench, close to the computer.

2. Check Figure T-1-1 in the Tutorial Chapter for the location of the USB port and the power 

socket on the IXTA.

3. Check Figure T-1-2 in the Tutorial Chapter for a picture of the IXTA power supply.

4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA. 

5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the 

power supply cable into the socket on the rear of the IXTA. Use the power switch to turn on the 

unit. Confirm that the power light is on.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 

the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 

will appear as the program is opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IPLMv4Standard.iwxgrp. Select this group 

and click Open.

4. Pull down the Settings menu, again. Select the HumanNerveConduction-LS2 settings file.

5. After a short time, LabScribe will appear on the computer screen as configured by the 

HumanNerveConduction-LS2 settings.

6. For your information, the settings used to configure the LabScribe software and the IXTA unit 

for this experiment are  programmed on the Preferences Dialog window which can be viewed 

by selecting Preferences from the Edit menu on the LabScribe Main window.
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7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 

of the following documents:

• Appendix

• Background

• Labs

• Setup (opens automatically)

The Equipment Setup

1. The subject should remove all jewelry from his/her right hand and wrist. 

2. Clean the areas where the electrodes will be attached with an alcohol swab (Figure HN-3-S1). 

Abrade the skin in those areas.

Figure HN-3-S1: Placement of the recording, ground, and two pairs of stimulating electrodes on the 

lateral edge of the right hand and arm.

3. Obtain seven disposable electrodes. 

4. Peel the protective shield off one of the electrodes and place it on the lateral edge of the little 

finger of the right hand, so the electrode button/snap is just above the first knuckle (Red (+) 

recording electrode in Figure HN-3-S1. 

5. Attach six additional electrodes to the subject’s right hand and arm so that they are placed in the 

following configuration:

• on the lateral edge of the palm, so the electrode button/snap is halfway between the base 

of the little finger and the wrist crease (Black (-) recording electrode on the hand 

• so the electrode button/snap is on the lateral edge of the wrist at the crease (Green (G) 

electrode on the hand.

• on the lateral edge of the forearm, so the electrode button/snap is 50-60 millimeters 
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above the wrist crease (Black (-) stimulating electrode.

• right next to the negative stimulating electrode towards the medial side of the forearm 

50-60 millimeters above the wrist crease (Red (+) stimulating electrode in Figure HN-3-

S1).

• on the lateral edge of the forearm 200 millimeters above the wrist crease (blank 

electrode.

• right next to the negative stimulating electrode towards the medial side of the forearm 

200 millimeters above the wrist crease (blank electrode in Figure HN-3-S1 .

6. Attach the connector on the end of the C-ISO-B3G cable to the iWire 1 input of the front of the 

IXTA (Figure HN-3-S2).

Figure HN-3-S2: Equipment needed to stimulate the ulnar nerve and record the impulses from the 

abductor muscle of the little finger.

7. Attach three color-coded electrode cables to the ground and Channel 1 inputs on the lead 

pedestal and snap the other ends onto the disposable electrodes, so that (Figure HN-3-S2):

• the red “+1” lead is attached to the electrode (A) closest to the pinkie.

• the black “-1” lead is attached to the electrode (B) on the center of the side of the hand.

• the green “C” lead (C) is attached to the electrode near the wrist..
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IXTA Isolated Stimulator

The IXTA has a high voltage stimulus isolator designed to deliver constant current to the nerve or 

muscle being studied. In situations where the resistance (R) along the path of the current increases, the 

voltage (V) increases to maintain the current (I in V = IR, Ohm’s Law). The ability of the IXTA to 

adjust the voltage to deliver the required current is known as voltage compliance. The upper limit of 

this compliance by the IXTA is set at 100 Volts.

Constant current devices differ from constant voltage devices when presented with an increase in 

resistance, like the dehydration of the conductive gel under the electrodes. As pointed out earlier, a 

constant current stimulator is voltage compliant. In constant voltage stimulators, the current delivered 

to the tissue decreases as the resistance increases because the power supply of the constant voltage 

device is not designed to deliver additional current. 

Although the IXTA can generate up to 100 Volts, the current delivered by the unit is limited to a 

maximum of 20 milliamperes, for a maximum duration of 10 milliseconds per pulse, and a maximum 

frequency of 50 pulses per second (Hz). At these levels, the maximum amount of power delivered by 

the IXTA will not cause injury or tissue damage.

The only parameter of the stimulus that is controlled directly by the IXTA is the current output. The 

current is selected using the Stimulator Control Panel. The HV Stimulator can deliver a maximum 

output of twenty milliamperes

The duration, frequency, and number of stimulus pulses generated by the stimulator are controlled by 

signals coming from the output of the IXTA. Pulses from the IXTA control the pattern of the stimuli 

released by the HV stimulator. The initial values of the pulses generated by the IXTA are programmed 

by the same settings file that configured the recording software. For example, if a pulse from the IXTA 

is programmed for a duration of 1 millisecond and a frequency of 1 Hz, the stimulator will generate a 

stimulus pulse with the same duration and frequency. 

If you examine the stimulator settings of the IXTA, you will notice that the amplitude of the pulses 

generated by the IXTA is set to 5 Volts. This is the voltage of signal required to control the stimulator. 

Remember that the current output is controlled by the software, and the voltage of the pulses are 

dependent upon the resistance of the stimulation circuit.

IXTA Stimulator Setup

1. Place the IXTA (Figure HN-3-S3) on the bench near the subject and the IWX/214. 

Warning: Before connecting the IXTA stimulting electrodes to the subject, check the Stimulator 

Control Panel to make sure the amplitude value is set to zero (0).

2. Obtain the power supply for the IXTA (Figure HN-3-S4) and connect the power adapter on the 

rear of the IXTA.

3. Instruct the subject to remove all jewelry before beginning the experiment. 

4. Make sure the IXTA is turned off (O). All the indicator lights should be off.
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Figure HN-3-S3: The IXTA stimulating electrodes.

Figure HN-3-S4: The front panel of the IXTA with the stimulating electrodes connected correctly.

Figure HN-3-S5: The IXTA power supply. 

Warning: Make sure the Amplitude is set to zero. 

5. Connect the color-coded stimulator lead wires to the High Voltage Current Stimulator. Make 

sure you push the safety connector of each lead wire into the appropriate socket as far as 

possible (Figure HN-3-S4).
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6. Connect the 2 stimulating electrodes as follows:

• Connect the black (-) stimulating lead to the electrode (D) on the lateral edge of the 

forearm 50-60mm above the wrist.

• Connect the red (+) stimulating lead to the electrode (E) adjacent to the one on the 

lateral edge of the forearm 50-60mm above the wrist.

• The “blank” electrodes (F and G) will be used when the nerve conduction velocity is 

determined.

7. Start with the stimulator programmed in this manner:

Table HN-3-S1: Settings on the Stimulator Window Used to Configure the Stimulator of the 

IXTA for Experiment HN-3.

Parameter Setting Parameter Setting

Stimulator Stim 1 Delay (sec) 0.05

Stimulus Mode Pulse Amplitude (V) 5

Start Stimulator with Recording S Pulses (#) 1

Time Resolution (msec) 0.01 Pulse Width (msec) 2

Toolbar Step

Frequency
1 Frequency (Hz) 1

Toolbar Step

Amplitude (V)
0.1

Time-Off

Amplitude (V)
0

Toolbar Step

Time (sec)
0.1

Holding

Potential (V)
0
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Experiment HN-3: Human Nerve Conduction

WARNING - The Stimulator should only be used for the method of application for which the 

Stimulator is intended as shown in the directions below.

NOTE: If using the IXTA and built in HV stimulator – all changes in Amplitude are entered 

directly into the Stimulator Control Panel.  Click “APPLY” to make any changes.

Exercise 1: Stimulus Strength and Muscle Response.

Aim: To determine the effect of stimulus strength on the response of the innervated muscle.

Procedure

1. Ask the subject to place his or her right hand on the bench with the palm down. Tell the subject 

to relax.

Note: The subject should make sure to relax his/her forearm and hand completely. Any tensing of the 

muscles would interfere with the recording.

2. Set the Amplitude knob on the front panel of the SI-200 unit to zero. 

3. Click Record button on the LabScribe Main window. LabScribe will record a single sweep with 

a display time of 50 milliseconds. Since the output amplitude of the SI-200 is set to zero, there 

should be no response from the abductor muscle. 

4. Increase the output amplitude of the SI-200 by rotating the Amplitude knob one half turn to the 

0.5 position which is equivalent to 1 mA or change the amplitude in the software. Click the 

Record button again and record another single sweep. Click the AutoScale button for the 

Muscle channel to improve the display of the muscle’s response (Figure HN-3-L1).

Figure HN-3-L1: Muscle response of abductor muscle of the little finger to stimulation of the ulnar 

nerve.
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5. Continue to increase the output amplitude of the SI-200 by rotating the amplitude knob one half 

turn at a time, each turn is an increment of 0.5. A maximum of twenty is possible. 

• Click the Record button to record a single sweep after each increase in the stimulus 

amplitude. 

• Continue to increase the output amplitude and record the response until the muscle 

impulse reaches a maximum level.

Note: You many need to continue to increase the amplitude until a response is generated.

6. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file(e.g. the iWorx or class folder). Click the Save button to save the file (as 

an *.iwd file).

Data Analysis

1. Click the Analysis icon in the LabScribe toolbar (Figure HN-3-L2) to view all the recorded 

sweeps. 

Figure HN-3-L2: The LabScribe toolbar.

2. Use the Windows control-click function to select the sweeps of interest from the Sweeps list on 

thebottom of the Analysis window. For comparison, superimpose the selected sweeps on each 

other by clicking the sweeps of interest. See Figure HN-3-L3. 

3. Select Title and V2-V1 from the Add Functions list if they are not already listed.

4. Go to the Sweep List at the top of the Analysis Window and select the sweep that has the lowest 

muscle response. Selecting a sweep from this menu will display the measured values of that 

sweep in the table at the top of the Analysis window.

5. Click the 2-Cursor icon in the LabScribe toolbar. Drag one cursor to the left of the stimulus 

artifact and the second cursor to the peak of the muscle response. The value for V2-V1 in the 

table at the top of the Analysis window is the amplitude of the muscle response.
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Figure HN-3-L3: Comparison of muscle responses to different stimulus amplitudes. Sweeps are 

superimposed in the Analysis window. Values for sweep #44 are shown.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter 

the names and values of the parameters from the recording to the Journal. To use these 

functions:

• Place the cursors at the locations used to measure the muscle response.

• Transfer the names of the mathematical functions used to determine the muscle response 

to the Journal using the Add Title to Journal function in the Muscle Channel pull-down 

menu.

• Transfer the values for the change in oxygen concentration to the Journal using the Add 

Ch. Data to Journal function in the muscle channel pull-down menu.

7. Record the stimulus amplitude used to generate the nerve response along with the other data for 

the sweep in the Journal.

8. Find the amplitudes (V2-V1) for the other selected sweeps in the same manner. Record these 

values and the values of the stimulus amplitudes used to generate these responses in the Journal.

9. Graph the amplitude of the muscle response as a function of the stimulus amplitude.

Questions

1. Does the amplitude of the action potential in each fiber in the ulnar nerve increase or do the 

numbers of nerve fibers in the nerve that respond increase with increased stimulus strength?

2. Does the amplitude of the muscle response increase because the response of each muscle fiber 

increases or the number of muscle fibers responding increases?

3. Which stimulus amplitudes are subthreshold? Which ones are suprathreshold or submaximal? 

Which ones are supramaximal?
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Exercise 2: Effect of Stimulus Polarity

Aim: To determine if the polarity of the stimulus pulse delivered to the nerve affects the latency and 

amplitude of the muscle response.

Procedure

1. Ask the subject to place his or her right hand on the bench with the palm down. Tell the subject 

to relax.

2. Set the Amplitude knob on the front panel of the SI-200 unit to a value that delivers the 

maximal muscle response as seen from Exercise 1. 

3. Click Record button on the LabScribe Main window to record a single sweep at this stimulus 

strength. 

4. Reverse the polarity of the stimulus pulse delivered to the ulnar nerve by reversing the positions 

of the stimulating leads on the subject’s forearm. Switch the stimulating leads by moving the 

red (+) stimulating lead to where the black (-) stimulating lead was snapped, and move the 

black (-) stimulating lead to where the red (+) lead was snapped.

5. Click Record button on the LabScribe Main window to record a single sweep at this stimulus 

polarity using the same stimulus amplitude. 

6. Select Save in the File menu.

Data Analysis

1. Click the Analysis icon in the LabScribe toolbar (Figure HN-3-L2) to view all the recorded 

sweeps. 

2. Use the Windows control-click function to select the sweeps of interest from the Sweeps list on 

the bottom of the Analysis window. 

3. Select Title, V2-V1, and T2-T1 from the Add Functions list if they are not already listed.

4. Go to the Sweep List at the top of the Analysis Window and select the sweep generated by 

normal stimulus polarity. Selecting this sweep from this menu will make the values of its 

measured functions appear in the table at the top of the Analysis window.

5. Click the 2-Cursor icon in the LabScribe toolbar. Place one cursor at the beginning of the 

stimulus artifact and the second cursor to the peak of the muscle response. The value for V2-V1 

in the table at the top of the Analysis window is the amplitude of the muscle response. The 

value for T2-T1 is a measure of the latency of the muscle response

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter 

the names and values of the parameters from the recording to the Journal. To use these 

functions:

• Place the cursors at the locations used to measure the muscle response.

• Transfer the names of the mathematical functions used to determine the muscle response 

to the Journal using the Add Title to Journal function in the Muscle Channel pull-down 

menu.
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• Transfer the values for the change in oxygen concentration to the Journal using the Add 

Ch. Data to Journal function in the muscle channel pull-down menu.

7. Find the amplitude (V2-V1) and the latency (T2-T1) for the muscle’s response to the stimulus 

of reversed polarity. Record these values in the Journal.

Questions

1. How does the amplitude and the latency of the muscle response change when the stimulus 

polarity is reversed?

2. What causes the difference to occur?

Exercise 3: Conduction Velocity

Aim: To measure the conduction velocity of the ulnar nerve by measuring the time required for the 

nerve impulse to travel from the site of the nerve stimulation to the site of the muscle response.

Procedure

1. Ask the subject to place his or her right hand on the bench with the palm down. Tell the subject 

to relax.

2. Set the Amplitude knob on the front panel of the SI-200 unit to a value that delivered a maximal 

muscle response. 

3. Click Record button on the LabScribe Main window to record a single sweep at this stimulus 

strength. 

4. Move the red (+) stimulating lead from Electrode E to Electrode G, and the black (-) stimulating 

lead from Electrode D to Electrode F.

5. Click Record button on the LabScribe Main window to record a single sweep with the stimulus 

delivered at this location on the forearm. 

Note: If you do not get a muscle response with the stimulating electrodes placed farther from the wrist, 

move the black (-) stimulus lead to Electrode E and the red (+) stimulus lead to Electrode F.

7. Select Save in the File menu.

8. Use a measuring tape, measure the actual distance between the two electrodes used as the (-) 

stimulating electrodes.

Data Analysis

1. Click the Analysis icon in the LabScribe toolbar to view the recorded sweeps. From the Sweeps 

list, select the sweeps recorded while the stimulating electrodes were in different positions. 

Superimpose these sweeps on each other by clicking the sweep numbers from this list at the 

bottom of the window.
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2. Select Title and T2-T1 from the Add Functions list if they are not already listed.

3. Go to the Sweep List at the top of the Analysis Window and select the muscle response 

generated from the proximal position of the stimulating electrodes. 

4. Click the 2-Cursor icon in the LabScribe toolbar. Drag one of the cursors to the peak of the 

muscle response in this sweep (Figure HN-3-L4). 

5. Go to the Sweep List at the top of the Analysis Window and select the muscle response 

generated from the distal position of the stimulating electrodes. 

6. Place the second cursor on the peak of this muscle response. The value for T2-T1 displayed in 

the table on the Analysis window is the time it took the compound action potential in the ulnar 

nerve to travel the distance between the two positions of the negative stimulating electrode.

Figure HN-3-L4: Cursors mark the time difference between the peaks of the muscle responses caused 

by stimulating electrodes at two different positions on the ulnar nerve. 

7. The functions in the channel pull-down menus of the Analysis window can also be used to enter 

the names and values of the parameters from the recording to the Journal. To use these 

functions:

• Place the cursors at the locations used to measure the muscle response.

• Transfer the names of the mathematical functions used to determine the muscle response 

to the Journal using the Add Title to Journal function in the Muscle Channel pull-down 

menu.

• Transfer the values for the change in oxygen concentration to the Journal using the Add 

Ch. Data to Journal function in the muscle channel pull-down menu.
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8. Calculate the conduction velocity (in m/sec) by dividing the distance (in mm) between the two 

positions of the negative stimulating electrode by the time (T2-T1) between the peaks of the 

muscle responses from those two positions. 

• For example:

65mm between positions of (-) electrode / 1.25ms = 52mm/ms = 52m/s
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